O
ICOM

INTRODUCTION

ADVANCED MANUAL

1 ADVANCED CONNECTIONS
2 ADVANCED OPERATIONS
3 ADVANCED SCOPE OPERATION

4 VOICE RECORDER FUNCTIONS

HF/50 MHz TRANSCEIVER 5 VOICE TX MEMORY OPERATION

I C 7 6 l-I O 6 SD CARD/USB FLASH DRIVE (ADVANCED)

7 MEMORY OPERATION

8 SCANS

9 CLOCK AND TIMERS (ADVANCED)

10 ANTENNA TUNER OPERATION (ADVANCED)

11 OTHER FUNCTIONS

12 MAINTENANCE (ADVANCED)

13 UPDATING THE FIRMWARE

INDEX

Instructions for advanced operations and additional
details are described in this manual.

See the Basic manual for the basic operations,
especially for new users.

Icom INnc.




Table of contents

1. ADVANCED CONNECTIONS.........ccccorimmrrimnnnnnns 1
W137 kHz band operation...........cccccceeiiniieeeinne 1
HConnectingthe RC-28 .........ccvvviveiiiiiieee, 2

Usingthe RC-28 ... 2
BFSK, AFSK, PSK connections...........ccccceeeenee. 3
EConnecting the AH-740........ccccovvveiiiiiiiieee, 4

2. ADVANCED OPERATIONS..........ccceenmrrerrncnenns 5

EBand Edge Beep........cccoeiviiiiiiii 5
Entering Band Beep Edges ........ccccoocieeeennnen. 5
BAdjusting the Drive Gain level............cccccvvvneeee.. 9
B[P Plus function...........cccoviiiiiiiinieee e, 9
ETracking function ..........cccooonieie e, 10
BYOX fuNCON. ....coeiiiiiii e 11
Adjusting the VOX function............ccccceenineen. 11
Turning ON the VOX function ............ccccuvveeee. 11
WATX fUNCHON ... 12
ATX monitor function ..o, 12
WOperating CW (ADVANCED)........cccccvvieeennnen. 13
About the CW Reverse mode...........ccceeneeee. 13
Using the Memory Keyer function (KEYER)... 13
Keyer memory edit menu (EDIT) ................... 14
Contest number menu (001 SET)................... 15
Keyer set menu (CW-KEY SET)....cceeeeevinnns 16
BOperating RTTY (FSK) ...oviieiiiiieeieeeee 17
Displaying the RTTY DECODE screen........... 18
RTTY decoding .......ccoovviiieieiiiiiiie e 18
Twin Peak Filter (TPF) ....cccoeviiieiieieeeeeee 18
Transmitting an RTTY memory content........... 19
Setting the RTTY Automatic TX/RX................. 20
Editing an RTTY memory........cccccceviiieneennnee 21
Turning ON the RTTY 109 ...eovvviiiiiiiiiiiiiiee, 22
Viewing the RTTY log contents...................... 23
RTTY Decode Log set ......cccovievieiiiiieneenne 23
BOperating PSK.......cccceeee e 25
Displaying the PSK DECODE screen 25
PSK decoding .......c..coeeviiiieiiiiiieee e 26
AFC/NET function ........ccceooeeeiiiieneee e, 26
Transmitting a PSK memory content 27
Setting the PSK Automatic TX/RX .................. 28
Editing a PSK memory...........ccoceeiiiieeeennnnen. 29
Turning ON the PSKI0g .......ccoviiiiiiiiiiieeen, 30
Viewing the PSK log contents.............cccoc.e.e.. 31
PSK Decode Log set .......ccccovuieeeeiiiiieneeee, 31
BFEM repeater operation ..........cccoovcveeeeiiiiieenenns 33
Setting the repeater tone frequency 33
Checking the repeater input signal ................. 34
BTone squelch operation..........cccocceeiiiiiieennns 35
EData mode (AFSK) operation ............ccceeeeenne 36
ETransverter operation ........cccccceeeevveencciiieennnnn. 36
Transverter setting example ...........ccccoeveeeen. 36

mAbout the 5 MHz frequency band operation ..... 37

3. ADVANCED SCOPE OPERATION...........c.cecucun. 36
ESpectrum SCOpe SCreenN .......cevvvveeeeeeviecenieeeeenn, 36
Setting the Center mode span...........ccccceeeee 36
Setting the Fixed mode range...........cccccee... 36
Directly tuning to a signal.............ccoccoeeeennnen. 37
Dual Scope screen ........ccceeevvieeeeeiiieeee e, 37
SWeep SPEed......ooiviiiiiiiiiiee e 38
Adjusting the Reference level......................... 38
BSCOPE SET SCreen .......oocceeeeiiiiieeeeiiiiiee e 39
4. VOICE RECORDER FUNCTIONS...........ccccvrunen 42
BRecording a QSO audio........cccoovvveeeeiiiiiieeens 42
Using the [RECIKeY ....coeeveiiiiiiiiiiieeeeee, 42
Using the [QUICK] KeY.......cooviieieiiniiiieeeeen. 42
Using the MENU screen ...........cccooeieeeeennnen. 42
BPlaying back a QSO audio..........ccccceevviiieeennnns 43
mPlaying back a recorded audioona PC ........... 44
BChecking the folder information
and file information ...........cccccciiiin 45
WDeleting files ..o 46
WDeleting folders........ccceoiiiiiii e 46
BRECORDER SET SCreen .........occcceeeeviiieeeennne 47
BPLAYER SET sCreen ........cccceevviiiieeiiiiieeeeee 48
HINSTANT REPLAY SET screen........c.cccceeeneee. 49
Hinstant Replay function ...........cccoociiinine 49
Recording the Instant Replay ......................... 49
Playing back the Instant Replay ..................... 49
5. VOICE TX MEMORY OPERATION............ccccvv.. 50
BRecording a Voice TX Memory ...........cccceeeennee 50
Recording .....ccooviiiieiiiiiie e 50
Playing back ..........cooviiiiiiiii e 50
BEntering a Voice TX memory name................... 51
B Transmitting a Voice memory content 52
Transmitting .......ooeeviiii e, 52
Repeatedly transmitting .........cccccceiiiinennnnn 53
Adjusting the output level...............cooeeennnee. 53
BYVOICE TX SET screen ......cccoeevvveeeiiniieeeeee 54

6. SD CARD/USB FLASH DRIVE (ADVANCED)... 50

ESaving the setting data onto

an SD card or USB flash drive .......................... 55
Bl oading the saved data files onto
an SD card or USB flash drive .......................... 56
BDeleting adatafile.........ocooiiiiiiii 57
mDisplaying the SD card or USB flash drive
iNformation...........ooooeveeeiiiiieee e, 58
mAbout the SD card and USB flash drive’s folders...59
The SD card folder..........ooovvveeeeieiiieeeeeeeeeee, 59
USB flash drive folder........cccccoevviviivveeeeneinnnnn. 59



Table of contents (Continued)

7. MEMORY OPERATION ........cccocmmrrccnereresccneeeens
EMemory channels ........ccccooceeiiiiiiee e
WSelecting a Memory channel .............ccccceeee
EEntering memory channel contents ..................
ECopying the Memory channel contents ............

Copying to the VFO ....coooviviiiiiieeeeeee,

Copying to the other Memory channel
EEntering a memory name ..........ccccceeeiiiieeeennne
BClearing a memory channel............ccccooceeene
EAbout the MEMORY screen ...........coocccvvveeeennn.
BMemO Pad .....coovvveiiiiiiieee e

Saving the displayed contents

intoa Memo Pad.......ccccceveeiiiiiieeeeeeeen

Calling up the Memo Pads........cccccccveveereeennn.

WSCAN tYPES .o
BPreparation ......ccccccoe e
Squelch status .......evvvveeeiiiie e
BSCAN SCIreEN ...ceveeeeee it
BMSCAN SET SCre€n .....ccccuevvieiiiieeeee e
BProgrammed SCan ........ccccveeieiieeeee e
Programmed scan operation ............ccccceeueee.
BMEMOrY SCAN ....coiiiiiiiiee et
Memory scan operation ............cccooevveeeeennnnen.
Setting the Select Memory channels
Memory scan operation ...........cccceevvveeeeennnnen.
4| Yo | o [
AF scan operation ........cccccceeeeiiiiieeieniiiieeenn

9. CLOCK AND TIMERS (ADVANCED).................
BNTP function ...
Using the NTP Time Synchronize function .....
Using the NTP function...........cccccoviiiennnnnn.
BSetting the Timers.......ccccoocviieee
Setting the Sleep Timer ........cccoveiiiiieeene
Setting the Daily Timer..........cccoveeiiiiiiiennne
Daily Timer setting items..........ccccccoiienennnnnn

10. ANTENNA TUNER OPERATION (ADVANCED)....
BUsing the [RX-I/O] in the Dualwatch operation ..........
ESelecting the antenna connector .....................

76

11.OTHER FUNCTIONS.........cccirrrrerrrcereen s 78
BRF Direct Sampling System..........ccccoecieeernnne 78
BAbout the RF/SQL Control..........ccccccvvvieeennnn... 79
EAbout “USB SEND/Keying”.......ccocceeeevcvveeeeennne 80
BMeasuring SWR........cccciii 81
B Selecting the Display Type .......ccoceveivvieeeennne 82
W Selecting the Display Font.........cccccooviiiiennnne 82
EmDisplaying my call Sign .......ccccoooieiiiiiiieneeee 82
BScreen Capture function.............cocccvvveeeenenn.. 83

Setting the Screen Capture function 83
Capturing @ SCreen .......ccccvveeeeeviccciiiiieeeeeeen, 83
Viewing a captured screen............ccoeeeevvvnneenn. 83
BREF adjustment...........ccoooviiiiiii 84

12. MAINTENANCE.......co oo 85
BCIEANING....coii it 85
HReplacing fuSe ..o 85

DC power cable fuses..........cccovcvvviiiiereeneeennn. 85
Circuitry fUSE .....coooviiiiiii i 86
ETouch screen calibration function .................... 87

13. UPDATING THE FIRMWARE ..........ccccccverrennens 88

LT T = | 88
About updating the firmware........................... 88
Checking the firmware version .........ccccc......... 88
Preparation ... 89
Unzipping the firmware folder...........c............ 89

BUpdating the firmware..........cccccccee i, 90

Icom, Icom Inc. and the Icom logo are registered trademarks of Icom Incorporated (Japan) in Japan, the United States, the United Kingdom,
Germany, France, Spain, Russia, Australia, New Zealand and/or other countries.

Microsoft, Windows and Windows Vista are registered trademarks of Microsoft Corporation in the United States and/or other countries.
Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries.

All other products or brands are registered trademarks or trademarks of their respective holders.



Functions and features of Adobe® Acrobat® Reader®

The following functions and features can be used with Adobe® Acrobat® Reader®.

* Keyword search

Click “Find” (Ctrl+F) File Y View Window Help

or “Advanced Search” Hc
(Shift+Ctrl+F) in the Edit menu to
open the search screen.

This is convenient when

searching for a particular word or [}
phrase in this manual.

*The menu screen may differ, El
depending on the Adobe® Acrobat® )
Reader® version.

Click to open the find or search
screen or advanced search screen.

B search [E=5 Hom (=)
Arrange Windows
Select All Ctri+A Where would you like to search?
® In the current document
Deselect All Shift+Ctrl+A ) All PDF Documents in
| b My Documents =
Copy File to Clipboard What word or phrase would you like to search for?

@ Take a Snapshot

Check Spelling

* Find screen

Previous Next

» Advanced search screen

[Z] Whole words only
[C] Case-Sensitive
[Clinclude Bookmarks
[ [Tl Include Comments

Search

Q Eind

Advanced Search

Ctrl+F

Shift+Ctrl+F

* Printing out the desired pages.

Protection

Accessibility

Click “Print” in File menu, and then select the paper

size and page numbers you want to print.

*The printing setup may differ, depending on the
printer. Refer to your printer’s instruction manual

for details.

*Select "A4" size to print out the page in the

equalized size.

G Edit View Window Help

B Open... Ctrl+0
Create PDF Online...
Save As... Shift+Ctrl+5
Save as Other L2
Send File L2
Close Ctrl+W
Properties... Ctrl+D

= Print.. Ctrl+P
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* Read Out Loud feature.
The Read Out Loud feature reads aloud the text in
this Instruction Manual.
Refer to the Adobe® Acrobat® Reader® Help for the
details.
(This feature may not be usable, depending on your
PC environment including the operating system.)

Rotate View »
Page Navigation »
Page Display »
Zoom »
Tools 4
Show/Hide »
Display Theme *
[?] Read Mode Ctri+H
|:_| Eull Screen Mode Ctrl+L

Ec‘? Tracker...

Read QOut Loud »

*The screen may differ, depending on the Adobe® Acrobat®
Reader® version.



1. ADVANCED CONNECTIONS

137 kHz band operation (European version only)

You can also operate between 135.7 kHz to 137.8
kHz in the CW mode.

The RF signal from [X-VERTER] is used for this
operation.

®The output of [X-VERTER] is —20 dBm so an up to
1 W linear amplifier may be required.
®See the connection illustration to the right.

* Be sure to turn OFF the transceiver and the
amplifier when connecting them.

+ To enable the [X-VERTER] connector, set the
“Transverter Function” item to ON, or connect a DC

(MENU) » [SET > Function > Transverter Function |

voltage to [ACC 2 (6: TRV)] (*1).

(MENU » [SET > Function > Transverter Offset |

* Set the offset frequency in the “Transverter Offset”
item to “0.000 MHz” to match the transceiver’s
operating frequency with the transmitting frequency.

* The antenna cannot be selected, and the internal
antenna tuner cannot be used while the Transverter
function is turned ON.

e =D &=
|@» 11 g
X-VERTER] = *
? I =enp Q[SEND]
%ANT Coaxial cable (50 Q)
Amplifier
[RF IN/
RX OouUT]
0
BPF/ | X ]/
LPF / [SEND]
---------------------------- ’-----4—JJC‘::UID—‘
J



1. ADVANCED CONNECTIONS

Connecting the RC-28

The optional RC-28 REMOTE ENCODER can be used as
a sub dial.

NOTE:

* See the RC-28’s manual to use the RC-28 with the
RS-BA1 IP REMOTE CONTROL SOFTWARE.

* Using the RC-28 with other than the USB cable
supplied with the RC-28, or connecting it through a
USB hub, is not guaranteed by Icom.

S ——

USB cable
(supplied with the RC-28)

< Using the RC-28

[TRANSMIT] LED
Lights while transmitting.

[LINK] LED
Lights while the RC-28 is connected to

C/_ the transceiver.
!

— Main dial
Changes the Sub band’s operating
frequency (default).

[F-1]/[F-2] LEDs*

[F1] lights when operating the Main band,
and [F-2] lights when operating the Sub
band.

—\

[F-1J/[F-2] buttons*
Selects the Main band or Sub band to
operate with the Main dial.

[TRANSMIT] button
Push to switch between transmit and
receive.

* The [F-1] and [F-2] buttons or keys are disabled
when “USB Dial Select” is set to “SUB Only.”

®Setting the “USB Dial Select” to “MAIN/SUB”
enables you to operate both the Main band and the
Sub band, using the RC-28.

(MENU) » [SET > Connectors > USB DIAL >
USB DIAL SELECT




1. ADVANCED CONNECTIONS

FSK, AFSK, PSK connections

The transceiver has a mode keys for RTTY and PSK. You can use a PC and an application software to operate
RTTY and PSK using a USB cable. However, if you want to operate AFSK or other digital modes, you can use
the ACC socket on the rear panel through an interface unit. See the interface circuit diagram below for details.
Refer to the software application’s instruction manual for setup details.

(lcom does not guarantee performance of the application software, PC, network device or network settings.)

When using the USB port

oS53

BER

To a USB port

A/B USB cable (user supplied)

TIP:
« If you set the “USB Serial Function” item to “RTTY Decode,” the decoded RTTY signals are output from the
USB port.

» Download the USB driver and the installation guide from the lcom website.
http://www.icom.co.jp/world/index.html
(Support > Firmware Updates/Software Downloads > Transceiver)

When using the ACC socket or the microphone connector

Interface circuit example for digital modes (User supplied)

 Connecting to [ACC 1] ! 2kQ:2kQ  10kQ |—Shield cable i
[———-— | (T1ri(:nk%t) Connectto )
@ B P LINE IN or I
| guotcane 1 MIC IN |
I ) 1 s | 2kQ: 2 kQ Shield cable I
a i -l No connection i
| lace: comeat o ] K] ggt)m Comectto | |
¢ [MIC: Connect to [F] sPoUT I
(Rearpanel) l'g ~ =
| o Pl ' No connection |
L..-.........I ' Shield cable 1
R B lr D-Sub25 D-Sub9 |
| &\ RTS i} |
+ Connecting to [MIC] [ i
® i ' Connect to |
| 1 COMport _J 1
1 ' |
I ! I
E | : i
1 1
(Front panel) L _!
NOTE: You cannot *1: NPN transistor ~ %2: Switching diode  i---- The sections shown in short dashes are required only when
operate FSK RTTY when (2SC1815) (1S1588) Baudot RTTY is used in the FSK (RTTY) mode.
you connect the circuit to (Not required for other digital modes such as SSTV or PSK)

the microphone connector.
®See pages 13-2 to 13-3 in the Basic Manual for details on the ACC 1 socket and MIC connectors.
3
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